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Abstract 

This document describes the hardware and software used to evaluate the DA9318 direct charging 
reference board. 
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1 Terms and Definitions 

GND Ground 

GUI Graphical User Interface 

IC Integrated Circuit 

JTAG Joint Test Action Group 

LED Light Emitting Diode 

LS Level Shifter 

OTG On-The-Go 

PC Personal Computer 

PD Power Delivery 

RCP Reverse Current Protection 

SAM3U  USB I
2
C Interface 

SCL Serial CLock 

SDA Serial DAta 

TA Travel Adaptor 

USB Universal Serial Bus 

2 References 

[1] DA9318 Datasheet, Dialog Semiconductor 

[2] 329-03-A_ SCH.pdf, Dialog Semiconductor 
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3 Introduction 

The purpose of the reference board is to demonstrate DA9318 in a direct charging application.  

The document covers a normal charging cycle, using an off-the-shelf charger IC and a charging cycle 
with the direct charging enabled. Direct charging means connecting the travel adaptor (TA) directly to 
the battery in the constant current charging phase. A block diagram of the DA9318 direct charging 
reference board is shown in Figure 1. 
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Figure 1: DA9318 Direct Charging Block Diagram 

The DA9318 direct charging reference board, see Figure 2, facilitates the measurement, evaluation, 
and configuration of a battery charging cycle when connected to a TA that includes the iW1780H 
primary side controller and iW676 secondary side controller chip set. 

Dialog’s software package SmartCanvas™ uses a simple graphical user interface which enables 
DA9318 to be controlled via the USB port of a PC. The mini USB connection is visible on the left side 
of the board. When the cable is connected to the USB port of the PC the green LED (D1) is on. 

The board contains jumper links, see Figure 6, to provide access to alternative configurations and 
measurement test points. Most standard operating modes are evaluated with minimal link changes. 
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Figure 2: DA9318 Direct Charging Reference Board (329-03-A) 
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4 Functional Description 

During direct charging the master charger of the battery operated device is bypassed and the TA is 
directly connected to the battery.  

The difference between normal charging and direct charging is illustrated in Figure 3.  

In order for the direct charging to work, the TA has to have a configurable output voltage and current 
limit.  
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Figure 3: Normal Charging (Top) and Direct Charging (Bottom) 

4.1 Master Charger 

The master charger is capable of handling a complete charging cycle without host interaction. 

The input current limit is set via GPIOs and the charging current and dynamic power management 
thresholds are set with external pull-down resistors.  

The charging statuses are communicated via LEDs. The master charger can be enabled with the 
nCE signal driven from the microcontroller. During direct charging the master charger is disabled. 
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4.2 Power Monitor 

Two power monitor ICs (INA226), fitted on the DA9318 direct charging reference board, allow for 
measurement of the master charger input voltage and input current, and for monitoring the battery 
current and voltage.  

That information is read out via the I
2
C interface and used in the control GUI software running on the 

PC.  

When direct charging is enabled, the DA9318 internal ADC is monitoring the input/output current and 
input/output voltage.  

Power monitoring is a safety feature associated with direct charging. The input power of the mobile 
device has to be compared to the output power of the TA. A mismatch indicates a fault condition and 
the charging has to be terminated.  

4.3 Direct Charging 

Reverse current protection (RCP) is enabled whenever DA9318 is not in the ACTIVE mode. 

DA9318 is capable of starting up when VIN is within the accepted range defined by VIN2OUT_MIN and 
VIN2OUT_MAX. If VIN is not within the accepted range during start-up, the start-up is aborted. 

When the above conditions are satisfied the DA9318 can be enabled by writing CP_EN to allow for 
direct charging. The TA voltage is set accordingly to allow an initial 6 A charge current into the 
battery. 

During direct charging the master charger is disabled. 

4.4 Over-Voltage Protection 

Over-voltage protection (OVP) is needed for general protection of devices connected to VBUS.  

TI TPD1S514, Fairchild FPF2280, and Kinetic KTS1682 can be used as they all are pinout 
compatible parts with very similar feature sets. 

 

 

  

http://www.ti.com/lit/ds/symlink/tpd1s514.pdf
https://www.fairchildsemi.com/datasheets/FP/FPF2280.pdf
http://www.kinet-ic.com/pro_detail.php?id/76.htm
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4.5 Direct Charging Sequence 

A sequence diagram for direct charging is depicted in Figure 4. 

NOTE 

The DA9318 direct charging reference board communication to the TA is achieved using a Dialog proprietary 
secondary-side to primary-side digital link communication protocol. The sequence diagram in Figure 4 is 

provided for information only. Please contact ic-support@diasemi.com for more information. 

 

DA9318TA
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Figure 4: Sequence Diagram for Direct Charging  

mailto:ic-support@diasemi.com
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5 DA9318 Direct Charging Reference Board Hardware 

The DA9318 direct charging reference board functionality can be broken down into sections, see 
Figure 5: 

● USB Type-C
™

 cable input, OVP switch, input connector. 

● Master charger / ADCs. 

● DA9318 direct charging. 

● USB interface (I
2
C communication) and USB reset. 

● Voltage monitoring connectors and IOs. 

● Battery and system connectors. 

 

Figure 5: Functional Sections 
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5.1 Default Link Positions and Connector Definitions 

 

Figure 6: Default Link Positions 

Table 1: Default Link Positions and Connector Definitions 

Reference Designator Position Function 

J1 
1 IN sense point 

2 GND sense point 

J2 NA IN connector 

J3 NA IN connector 

J4 1-2  I
2
C pull-up to VDD_IO 

J5 NA OUT connector 

J6 NA OUT connector 

J8 NA Line transient connector 

J9 NA OUT load transient connector 

J10 NA GND connector (IN side of board) 

J11 NA GND connector (IN side of board) 

J12 NA GND connector (OUT side of board) 

J13 NA GND connector (OUT side of board) 

J14 NA NA 

J15 NA JTAG: reserved 

J16 NA Measurement header 
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Reference Designator Position Function 

J17 1-2 (Open) Important: This erases the USB IC firmware. DO NOT SHORT 

J18 
1-2 (Close) I

2
C bypass: SAM3U SCL connected to LS input 

2-3 I
2
C bypass: SAM3U SCL connected to LS output (bypass) 

J19 
1-2 (Close) I

2
C bypass: SAM3U SDA connected to LS input 

2-3 I
2
C bypass: SAM3U SDA connected to LS output (bypass) 

J20 1-2 (Open) 
PWREN shorted to SYS, DA9318 will immediately go from NO-
POWER mode to SHUTDOWN mode when SYS power is supplied. 

J21 1-2 (Close) I
2
C level shifter IC enabled 

J22 
1-2 (Close) SCL from SAM3U connected to DA9318 

3-4 (Close) SDA from SAM3U connected to DA9318 

J23 
1-2 (Close) I

2
C LS power selection: connected to VDD_IO 

2-3 I
2
C LS power selection: connected to AVDD 

J24 NA VBATN connector for cell sensing 

J25 
1-2 (Close) nIRQ PU selection: VDD_IO 

2-3 nIRQ PU selection: AVDD 

J26 1-2 (Close) Sets VDD_IO to 1.8 V (if J27 open)  

J27 1-2 (Open) Sets VDD_IO to 2.8 V (if J26 open)  

J28 NA VBATP connector for cell sensing 

J29 
1-2 (Close) nFAULT PU selection: VDD_IO 

2-3 nFAULT PU selection: AVDD 

J30 NA USB inlet 

J31 
1-2 (Close) Both sides of level shifter set to VDD_IO 

2-3 Level shift from AVDD to VDD_IO 

J32 

1-2 (Close) nIRQ connected to level shifter and SAM3U 

3-4 (Close) nFAULT connected to level shifter and SAM3U 

5-6 (Close) CC1 connected to level shifter and SAM3U 

7-8 (Close) CC2 connected to level shifter and SAM3U 

9-10 (Close) PWREN connected to level shifter and SAM3U 

11-12 (Close) nCPEN connected to level shifter and SAM3U 

J33 
Close (Default) Short GND to VBATN for a local pack sensing 

Open GND and VBATN disconnected to allow cell sensing 

J34 
1 SYS sense point 

2 GND sense point 

J35 NA SMA connector for measuring SYS 

J36 
Close (Default) Short VOUT_DA9318 to VBATP for a local pack sensing 

Open VOUT_DA9318 and VBATP disconnected to allow cell sensing 

J37 
1-2, 3-4, 5-6 
(Close) 

IN connector shunt to IN of DA9318 

J38 
1-2 CC2 (labeled as TP7) pulled up to rail selected by J41 

2-3 (Close) CC2 (labeled as TP7) pulled to ground 
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Reference Designator Position Function 

J39 
1-2 CC1 (labeled as TP6) pulled up to rail selected by J40 

2-3 (Close) CC1 (labeled as TP6) pulled to ground 

J40 
1-2 (Close) CC1 (labeled as TP6) PU selection: VDD_IO 

2-3 CC1 (labeled as TP6) PU selection: AVDD 

J41 
1-2 (Close) CC2 (labeled as TP7) PU selection: VDD_IO 

2-3 CC2 (labeled as TP2) PU selection: AVDD 

J42 
1-2 (Close) nIRQ pulled up to rail selected by J25 

2-3 nIRQ pulled to ground 

J43 
1-2 (Close) nFAULT pulled up to rail selected by J29 

2-3 nFAULT pulled to ground 

J44 

1-2 (Open) Important: DO NOT SHORT 

2-3 (Open) 

Connect PWREN to GND to enter NO-POWER mode. Make sure 
J20 is open before installing a jumper in this position. 

Note: J44 pin 2 is connected to AVDD by default 

J45 
1-2 (Close) nCPEN shorted to AVDD 

2-3 nCPEN shorted to GND 

J47 NA NA 

J48 NA SYS connector 

J50 NA SMA connector for measuring C2N (labeled as C2M) 

J51 NA SMA connector for measuring C2P 

J52 NA SMA connector for measuring IN 

J53 NA SMA connector for measuring OUT 

J54 NA SMA connector for measuring C1N (labeled as C1M) 

J55 NA SMA connector for measuring C1P 

J56 1-2 (Open) Master Charger thermistor sensor short to ground  

J57 1-2 (Close) Master Charger Status read connection to Atmel 

J58 1-2 (Close) Master Charger Current Limit settings 

J59 1-2 (Close) OTG to Ground 

J60 1-2 (Close) INTB GPIO connection to SAM3U 

J61 1-2 (Close) Master charger enable through GPIO 

J62 1-2 (Close) Master charger enable 

J63 1-2 (Open) PGB GPIO connection to SAM3U 

J64 1-2 (Close) DA9318 input disconnect 

J65 1-2 (Open) DA9156 input disconnect 

J66 1-2 (Open) DA9156 IRQ pull-up 

J67 1-2 (Open) DA9156 ISET pull-up 

J68 1-2 (Open) DA9156 GPIO0 pull-up 

J69 1-2 (Open) DA9156 GPIO1 pull-up 

J70 NA NA 

J71 NA NA 
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Reference Designator Position Function 

J72 1-2 (Close) I
2
C high voltage level shifter enable 

J73 
1-2 (Close) 

Master charger thermistor connection 
2-3  

J74 1-2 (Open) Master charger DSEL settings 

J75 
1-2  

Master charger PSEL settings 
2-3 (Close) 

J76 
1-2 DA9156 battery ID connected to variable impedance 

2-3 (Default) DA9156 battery ID connected to fixed impedance 

J77 
1-2 (Open) Dplus connected to SAM3U PB11 port 

2-3 (Open) Dplus connected to SAM3U PC15 port 

J78 
1-2 (Open) Dplus connected to SAM3U PB12 port 

2-3 (Open) Dplus connected to SAM3U PC16 port 

J79 
1-2 (Close) Both sides of level shifter set to VDD_IO 

2-3 Level shift from AVDD to VDD_IO 

J80 NA Load transient connector 

J81 NA USB-C inlet 

S3 NA Push button to reset the USB IC 
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5.2 USB Interface 

The DA9318 direct charging board uses an ATMEL
®
 SAM3U

®
 microcontroller as the USB 

transceiver, programmed to deliver the following functionalities: 

● I
2
C control interfaces. 

● Discrete digital IO control (General Purpose Input Output (GPIO) and dedicated functions). 

5.2.1 USB Power and GUI Reset 

The USB is powered by an on-board regulator (VR2), see Figure 7. Pressing the USB RESET switch 
S3 shuts down the on-board regulator VR2, powering down the supply for the SAM3U (USB I

2
C 

interface). This resets the GUI communication with the reference board. 

 

Figure 7: USB Interface Connector and Reset Switch 

Table 2: Power Configuration Switch 

Switch Name Reference 
Designator 

Type Function 

USB RESET S3 Push 
button 

Shuts down the on-board regulator that generates the 
interface supply 

5.3 Power Supplies 

The DA9318 direct charging board is powered up when a power source is connected to IN (J48). IN 
operating voltage range is +5.5 V to +10.5 V. 

The VDD_IO voltage is generated by an on-board regulator (VR1) supplied from the +5 V USB. By 
default, the on-board generated VDD_IO is +1.8 V (J26 jumper is POP, J27 jumper is UNPOP): 

● To change the on-board VDD_IO to +2.8 V, J27 must be fitted while J26 is UNPOP. 

● To change the on-board VDD_IO to +3.3 V, J26 and J27 must be UNPOP. 

NOTE 

For correct operation, connect the reference board to a USB port capable of supplying 500 mA. 
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6 DA9318 Direct Charging Reference Board Software 

The board is controlled using a graphical user interface (GUI), which requires a PC operating 
Windows

®
 2000/XP/Vista/Windows 7 with a USB1.1 or USB2 interface. The GUI allows the user to: 

● Perform raw write and read operations to all control registers on Dialog and non-Dialog ICs. 

● Monitor the charging status. 

● Plot the DA9318 efficiency over time with saving and zoom feature. 

● Plot the master charger efficiency over time with saving and zoom feature. 

● Plot the DA9318 temperature over time with saving and zoom feature. 

● Poll the DA9318 registers. 

● Read ADC data from DA9318 (VIN, VBAT, IIN, IOUT and TJUNC) when the DA9318 is enabled. 

● Read ADC data from external ADC ICs (VIN, VBAT, IIN and IOUT) when the master charger is 
enabled. 

● Control the TA voltage and current limit; and master charger voltage termination, charge current 
and current limit. 

● Send default settings. 

● Read all registers displayed. 

● Clear faults. 

6.1 GUI Installation 

The files required to install the software are available on the supplied USB drive. To install the 
DA9318 reference board software: 

1. Run setup_DA9318_Reference_GUI.x.x.x.xx.exe. 

2. On completion, insert the USB cable and apply VSYS and VIN.  

a. For first time users Windows should detect the attached USB device. If this is not the case, it 
may be necessary to install the driver by navigating to the required driver file in the USB 
driver directory, see section 6.2. After installing the driver, reboot the PC to ensure correct 
operation.  

3. Start the software by running DA9318 Reference GUI.exe. 
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6.1.1 GUI Installation Step By Step Guide 

 

Figure 8: GUI Setup License Agreement 

1. Select I accept the agreement then click Next. 
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Figure 9: GUI Setup Destination Location 

2. Click Next. 

 

Figure 10: GUI Setup Start Menu Location 

3. Click Next. 
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Figure 11: GUI Setup Additional Tasks 

4. Select the Create a desktop shortcut check box (if required) and click Next. 

 

Figure 12: GUI Setup Start Installation 

5. Click Install. 
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Figure 13: GUI Setup Finish and Launch 

6. Click Finish. 

 

Once the installation is completed, you may need to restart your computer.  

When the software is installed, insert the USB cable before applying VSYS and VIN. The DA9318 
SmartCanvas software can be started after power up. 

6.2 Initial USB Connection 

On connecting the USB to the PC for the first time, the SAM3U USB driver will request driver 
updating/installation from the Windows operating system. On Windows 7 (32-bit) operating systems 
(OS) the driver usually installs automatically. On Windows 7 (64-bit) machines it is common for the 
complete driver installation to fail. If this happens, install the driver manually by following these steps: 

1. Control Panel → Devices and Printers (double-click device with yellow exclamation sign). 

2. Update Driver. 

3. Browse my computer for driver software. 

4. Select the Driver folder location: C:\Dialog Semiconductor\Power Management\DA9318 
Reference GUI\Driver. 

5. If Windows warns about the driver, select Install anyway. 

6. Remove the USB cable and then re-insert it into the reference board. 
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7 GUI Software 

Run the DA9318 Reference Board GUI software by clicking the shortcut on the appropriate item in 
the Start menu (All Programs → Dialog Semiconductor → Power Management → DA9318 
Reference GUI). The screen shown in Figure 14 is displayed. 

The minimum recommended setting for the PC display size is 1024x768 pixels. Font size on the PC 
display should be Normal (95 dpi).  

NOTE 

A display size other than the recommended setting will affect the way in which the panels appear. 

7.1 Controls 

Figure 14 shows the main GUI interface. 

 

Figure 14: Main GUI Interface 
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7.2 Control Widgets 

7.2.1 Enable/Disable Polling 

The polling switch enables or disables polling of the device registers and the refreshing of the 
registers’ controls on the GUI interface. 

 

Figure 15: Polling 

7.2.2 Charging Status Indicators 

The Status Indicators window, see Figure 16, displays the following information: 

● Pre-Charge: When the battery voltage is below 3 V (VBATLOW), the battery is pre-charged at a 
lower charge current of 128 mA. 

● Constant-Current: When the battery voltage is above 3 V and below the constant voltage 
threshold; this indicator will light green. This indictor will also light green in conjunction with the 
Slave Charging indicator during direct charger. 

● Constant-Voltage: When the battery voltage reaches the master charger constant voltage 
termination voltage threshold, this indicator will light green indicating charger is in constant 
voltage. 

● Slave Charging: This indicator will light green when slave charging (DA9318) is enabled 
indicating direct charging. 

● DONE: This indicator will light green when charge cycle is complete. 

 

The update actions are as follows: 

● Read All Registers – even if the hardware device is not being actively polled then all the 
registers can be polled once by pressing this button. 

 

Figure 16: Board Status 

 

Figure 17: Read All Regs Button 
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7.2.3 Raw I/O 

The Raw I/O control sends the entered device address, register address and data on the I
2
C 

communications interface. If the information sent is not valid then the I
2
C message will return NACK 

an error message will be displayed in the Status window. 

 

Figure 18: Raw I/O 

7.2.4 Interface Control Information 

In the View menu, click on Status, the Status window is displayed. 

In the Status window, select the Log tab and Log Level: Info. This will display interface control 
information including: name, parent register and the bits to which this control corresponds, current 
value, whether it is read-only or R/W access, and finally a description of each possible setting. 

 

Figure 19: Interface Control Information 

7.2.5 I2C Bus Scan 

In the Tools menu, click on Scan I2C, the I2C Bus Scan window is displayed. 

In the I2C Bus Scan window, selected Scan. Once the scan has completed, all I
2
C slave addresses 

will be displayed.  
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Figure 20: I2C Bus Scan 

7.2.6 Settings 

In the Options menu, click on Settings, the Settings window is displayed. 

The U2 and U8 INE226 ADC ICs can be configured in the Settings window. 

 

Figure 21: Settings 
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7.3 Quick Start Guide 

The recommended steps to operate the DA9318 direct charging reference board are shown below. 

Master Charger

DA9318

Overvoltage 
Protection IC

Travel 
Adaptor (TA)

DLINK

VBUS

SYS

BATT

BATT

 

Figure 22: Test Setup 

 

 

Figure 23: GUI Configuration 
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7.3.1 Operational Steps 

The following operational steps assume that a battery is inserted initially and then the TA is inserted 
to J81. In addition, J30 must be connected to the USB port of a computer for I

2
C communication 

using the DA9318 Reference Board SmartCanvas GUI software. 

NOTE 

The battery voltage should be less than 3.6 V to allow for a 6 A initial charge current. 

The button or status indicator locations for each operational step are highlighted in Figure 23: 

1. Click the Read All button, to read all registers to their current states. 

2. Click the Send DFLT button, to send the default settings/ 

3. Click the No Faults button, to clear any faults. 

4. Enable the Polling switch. The Constant-Current status indicator flags green, signaling that the 
master charger is enabled. 

5. Enable the Master/Slave switch. Direct charging is enabled via DA9318 and the Constant- 
Current and Slave Charging status indicators flag green. 

6. When the Constant-Voltage status indicator flags green, step down the TA CC Setting by 
100 mA steps (or greater initially) until the minimum value is reached (400 mA). Note that for 
each step the Constant-Voltage status indicator will alternately flag red and green as the battery 
charges up.  

7. When the TA CC Setting has reached the minimum value, disable the Master/Slave switch to 
return to master charger until the DONE status indicator flags green, signaling the end of the 
charge cycle. 

NOTE 

Unless the watchdog timer is serviced, it is recommended to disable it by disabling the Chgr Watchdog switch 

while the master charger is enabled.  

This is to ensure that the master charger does not initiate a power-on-reset when the watchdog timer has 
expired. Indeed, when the watchdog timer has expired, the device returns to default mode and all registers are 

reset to default values.  
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